
Obsah
Úvod 9

KAPITOLA 1

Kreslení a základní úpravy 17
Úprava polohy textu během psaní 17
Úprava polohy výběru během kreslení 17
Uložení sledu úprav pro opakované použití (Akce) 17
Použití akce 18
Úprava několika obrázků současně (Batch) 19
Zjednodušené ukládání upravených obrázků (Batch) 19
Jak zjistit tiskovou velikost obrázku 20
Změna tiskové velikosti obrázku 20
Dočasná změna tiskové velikosti obrázku 21
Sloučení vrstev do nového obrázku 22
Zarovnání objektů 22
Zarovnání objektů do okna dokumentu 23
Zarovnání objektů přichytáváním 24
Zarovnání objektů k vodítkům pravítka 24
Vytvoření pravidelných rozestupů mezi objekty 25
Kreslení 26
Úprava barvy 26
Úprava tvarů 27
Obdélník se zakulacenými rohy 27
Kreslení mnohoúhelníků 28
Kreslení hvězd 28
Kreslení hvězd s kulatými rohy 29
Kreslení hvězd se zaoblením 29
Kreslení přímek a šipek 29
Kreslení přednastavených tvarů 30
Vytváření vlastních tvarů 31
Ukládání vlastních tvarů 32
Sčítání a odčítání tvarů 33
Vytvoření zaoblených okrajů 33
Základní výběry oblasti 35
Použití výběru 36

K1315.indd   3K1315.indd   3 23.10.2008   11:12:5423.10.2008   11:12:54



Obsah4

Zrušení výběru a Vybrat vše 36
Výběr z vrstvy 36
Nepravidelné tvary výběru – Laso (Lasso Tool) 37
Magnetické laso 38
Kouzelná hůlka – Magic Wand Tool 39
Sčítání a odčítání výběrů 40
Výběr podle barevného rozsahu (Color Range) 41
Rychlá maska (Quick Mask) 41
Průhledné okraje 42
Úprava tvaru výběru 43
Úprava tvaru obsahu výběru 44
Barevná výplň 44
Výplň barevným přechodem 45
Vlastní vzorek 46
Vyplnit vzorkem 46
Vzorek s navazujícími okraji – Posun (Offset) 47
Vzorek s navazujícími okraji – poloha objektů 48
Vzorek z části fotografie 49
Ohraničení výběru 50
Vytvoření cesty (Path Tool) 51
Úprava cesty 52
Vytažení cesty (Stroke Path) 53
Cesta z výběru 54
Export cesty do Illustratoru 54
Základní vrstva 54
Nová vrstva 55
Duplikování vrstvy 55
Kopie části vrstvy 56
Změna pořadí vrstev v dokumentu 56
Interakce vrstvy 56
Uložení výběru jako kanálu 57
Editace masky v kanálu 58
Načtení masky z kanálu 58
Přirozený stín 58
Zadní stín 60
Přirozený odraz 60
Využití Smart objektů 61
Využití Smart filtrů 63

K1315.indd   4K1315.indd   4 23.10.2008   11:12:5423.10.2008   11:12:54



Obsah 5

KAPITOLA 2

Barevné transformace 65
Převod fotografie na černobílou – Odbarvit (Desaturate) 65
Převod fotografie na černobílou – Duplex (Duotones) 65
Převod fotografie na černobílou – Odstín a Sytost (Hue/Saturation) 66
Změna barvy – Odstín a Sytost (Hue/Saturation) 67
Změna barevného tónu – sépiová kost 68
Duplex – Duotone 69
Vyvážení barev fotografie (Color Balance) 70
Tónování fotografie – Photo Filter 71
Nedestruktivní úpravy pomocí vrstvy úprav – Selective Color 72
Náhrada barevných odstínů pomocí filtru Match Color 73
Ochrana barev před přebarvením  74
Změna barevného odstínu části obrázku 74
Zvýraznění fotografie pomocí přednastavených křivek 76
Převod do černobílé 77

KAPITOLA 3

Úprava fotografií 79
Oprava vad pomocí automatických úrovní 79
Korekce barev po skenování 80
Automatické rozřezání fotografií po naskenování 81
Odstranění moaré po skenování 81
Zvýšení kontrastu fotografie 83
Zaostření fotografie pomocí kopie vrstvy 83
Zaostření fotografie pomocí filtru Horní propust 84
Změna kontrastu – Shadow/Highlight 85
Zvýšení sytosti barev 86
Retušování – Healing Brush 87
Retušování – Razítko (Stamp Tool) 88
Fotomontáž 89
Převod fotografie do režimu HDR (High Dynamic Range) 92
Dosažení HDR s jedinou fotografií 96
Vylepšení portrétní fotografie pomocí techniky high-key 98
Úprava fotografie pomocí techniky low-key 99
Zvýraznění středních odstínů 101
Karikatura 102
Karikatura – komiksový vzhled 105
Vytvoření panoramatické fotografie 107
Zpracování fotografií pomocí Camera Raw 110

K1315.indd   5K1315.indd   5 23.10.2008   11:12:5423.10.2008   11:12:54



Obsah6

Převod do černobílé pomocí Camera Raw 113
Rozostřené pozadí 113

KAPITOLA 4

Efekty, filtry a textury 115
Generování mraků (Clouds) 115
Filtr Oblaka s dokonalými mraky 116
Vodní hladina 117
Horizont nad vodní hladinou 118
Oheň 119
Tráva 119
Fraktální pozadí 120
Kresba z fotografie pomocí vyhledání a zvýraznění obrysů 122
Kresba z fotografie pomocí filtru Chytré vyhlazení 123
Vytvoření prstenu pomocí stylů vrstev 124
Styly vrstev s maskou vrstvy 125
Vylepšený plastický vzhled 127
Přizpůsobení textury změně tvaru 129
Ohraničení přechodem 130
Mozaikové pozadí 130
Andy Warhol efekt 131
Přesné nastavení práhu 132
Zasněný vzhled pomocí filtru Blur 133
Kolorovaná fotografie 134
Omezení barevných odstínů 135
Rozostření fotografie 135
Zvýraznění kresby 137
Neostrost ve stylu glamour 138
Akvarel 139
Ulice po dešti 141
Úprava perspektivy 142
Odraz ve vodě 144
Komiks 146
Dvoubarevný komiks 148
Válečná fotografie 148
Zjemnění kontrastu makrofotografie 149
Koláž z fotografií 150
Plynulý přechod pomocí masky 153
Tečkovaný přechod 155
Vlajka ve větru 156
Reliéf z pískovce 158
Srst dalmatina 160

K1315.indd   6K1315.indd   6 23.10.2008   11:12:5423.10.2008   11:12:54



Obsah 7

Textura vojenského maskování 161
Retušování v perspektivě – Vanishing point 163
Umístění obrázku do mřížky perspektivy 165
Změna perspektivy (korekce objektivu) 167

KAPITOLA 5

Kouzla s textem 171
Přednastavení vlastností textu 171
Obtékání textu 171
Neonová trubice 173
Výbušný text 174
Vyplnění textu obrázkem 175
Editace textu s obrázkem 176
Trojrozměrný text 176
Vystínování trojrozměrného textu 178
Prolnutí textu do pozadí 179
Poškozený text 180
Text pokrytý vzorkem 181
Text ve stylu šedesátých let 183
Text v podobě sušenek 185
Text s vypálenými okraji 187
Text poleptaný kyselinou 188
Text připomínající Ementál 189
Digitální čas 191
Technický text 193
Okousaný text 195
Přepůlený text 196
Želé 198
Diamant 200
Průhledný text 200
Zasí�ovaný text 202
Písmo ve stylu Pána prstenů 203
Text v písku 206
Textura dřeva 207

KAPITOLA 6

Vše pro web 209
Rámeček tabulky s vlastními okraji 209
Uložení pro web se změnou velikosti 211
Nastavení průhlednosti ve formátu GIF 211
Vytvoření webové fotogalerie 213

K1315.indd   7K1315.indd   7 23.10.2008   11:12:5423.10.2008   11:12:54



Vlastní nastavení vzhledu fotogalerie 215
Nastavení popisu a dalších informací o obrázku 216
Průhledná tlačítka 217
Změna barvy tlačítka 218
Úprava tvaru tlačítka 219
Průhledné tlačítko se stínem 220
Vytvoření prezentace obrázků (Slide Show) 221
Změna času zobrazení snímku animace 222
Kontrola přehrávání animace 222
Změna pořadí snímků v animaci 223
Vytvoření snímků z vrstev 224
Animace vrstev 224
Změna režimu přehrávání animace 225
Tween animace pohybu 226
Tween animace průhlednosti 227
Otočení pořadí snímků (Reverse) 228
Kopírování snímků animace 228
Rozložení animace na vrstvy 229
Export animace jako SWF 230
Export snímků animace jako obrázků 230
Náhled animace 231
Jednoduché tlačítko 232
Tlačítko s kotvou 232
Použití tlačítka na internetové stránce 233
Jednoduché rollover tlačítko 234
Uložení a použití rollover tlačítka 235
Animované menu 236
Vytvoření obrazové mapy (Image Map) 238
Více tlačítek v jedné obrazové mapě 239
Definování kruhová aktivní oblasti 239
Vytvoření složení aktivní oblasti 240
Úpravy složených oblastí 240
Kopírování aktivních oblastí 241
Zarovnání aktivních oblastí 241
Rámeček s roztřepenými okraji 241
Nepravidelný rámeček pomocí filtru Posunout 243
Stylové pozadí pomocí galerie vektorových tvarů 244
Travnaté pozadí 246
Vlastní vektorové pozadí 248
Pozadí v podobě zkorodovaného plechu 250

Rejstřík 251

Obsah8

K1315.indd   8K1315.indd   8 23.10.2008   11:12:5423.10.2008   11:12:54



Úvod
Komu je a komu není tato kniha určena? Pokud nemáte s Photoshopem žádné zkušenosti, neče-
kejte, že vám kniha představí všechny jeho možnosti. K tomu jsou určeny referenční příručky. 
Zde naleznete hotové příklady, které budete schopni krok za krokem zvládnout i bez hlubších 
znalostí programu. Některé základní znalosti ale budeme očekávat a těm je věnována následující 
kapitola. Jedná se o způsob používání pracovní plochy, nástrojů a paletek, na které jsou odkazy 
v kapitolách knihy.

Obrázek Ú.1 Základní rozvržení pracovní plochy
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Úvod10

Pracovní plocha
Pracovní plocha je pro uživatele operačního systému Windows tvořena základním oknem, ve 
kterém jsou umístěny panel nabídek, panely nástrojů a paletky. Na počítačích s operačním sys-
témem Mac OS se na ploše monitoru zobrazí pouze panely nástrojů a paletky, ale jejich vzhled 
a funkce jsou totožné.
Základní rozmístění panelů nástrojů a paletek vidíte na obrázku.
Panely nástrojů a paletky mají několik společných vlastností. Můžete je skrýt, zobrazit, spojovat 
do skupin a posouvat libovolně po pracovní ploše, a jejich rozložení uložit pro opakované použi-
tí. To vše vám pomůže optimálně využívat pracovní plochu monitoru, která se jinak při otevření 
všech paletek značně zmenší. Nyní se podíváme na panely nástrojů a paletky, které je potřeba 
znát pro vypracování příkladů z této knihy.

Panel nabídek
Panel nabídek je umístěn v horní části pracovní plochy. Budeme se na něj odka-
zovat formulací „...zvolte příkaz Soubor → Otevřít (File → Open)“. Na panelu 
nabídek naleznete příkazy, rozdělené logicky do skupin se stejným nebo podob-
ným tématem. Některé nabídky příkazů mají tři úrovně. To poznáte podle šip-
ky vpravo od názvu příkazu. Odkaz na třetí úroveň pak bude vypadat takto „...
Obraz → Přizpůsobení → Úrovně (Image → Adjustments → Levels).

Panel nástrojů
Panel nástrojů může mít dvě podoby, mezi kterými se přepínáte šipkami 
v levém horním rohu rámečku panelu nástrojů. Každá podoba má své výhody 
i nevýhody a liší se jen rozmístěním tlačítek nástrojů. Nástroje jsou základem 
všeho, co budete potřebovat při kreslení nebo úpravách obrázků a fotografi í. 
Nástroj zvolíte tak, že klepnete na jeho tlačítko v panelu nástrojů, nebo stisk-
nete jeho klávesovou zkratku (např. nástroj Klonovací razítko+S). Po najetí 
kurzorem na ikonku nástroje se vám zobrazí jméno nástroje. Některé nástro-
je skrývají pod jedním tlačítkem i více nástrojů, nebo jejich variant. Takový 
kombinovaný nástroj poznáte podle malé šipky v pravém dolním rohu tla-
čítka nástroje. Stačí na tlačítku přidržet kurzor myši se stisknutým levým 
tlačítkem a z tlačítka se vysune celá nabídka. Současně se změnou nástroje 
se změní i vzhled kurzoru myši. Podle něj také snadno poznáte, jaký nástroj 
máte právě zvolený. Nejdůležitější nástroje si nyní popíšeme.

 Posun (Move Tool)
Tento nástroj slouží k pohybování objekty (vrstvami), ze kterých se obrázek 
skládá. Přidržením tlačítka myši s kurzorem umístěným kdekoli na ploše 

Obrázek Ú.2 Panel nabídek

Obrázek Ú.3 
Panel nástrojů
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dokumentu můžete posouvat aktivní vrstvou. Když umístíte kurzor dovnitř výběru, pohybujete 
pouze obsahem výběru.

 Výběr (Marquee Tool)
Tímto nástrojem provedete výběr pravidelné oblasti, se 
kterou potřebujete pracovat. Tvar oblasti je buď čtyřú-
helník, kruh, elipsa, svislá, nebo vodorovná čára. Kres-
lení provedete tak, že umístíte kurzor myši do počátečního bodu, stisknete tlačítko myši a kur-
zor posouváte do protilehlého bodu oblasti. Nástroj vykreslí zvolený tvar.

 Laso (Laso Tool)
Tímto nástrojem provedete výběr nepravidelné oblasti. Ta 
může být nakreslená souvislou čárou nástrojem Laso (Laso 
Tool), nebo složená z několika úseček pomocí nástroje Mno-
hoúhelníkové laso (Polygonal Laso Tool). 

 Kouzelná hůlka (Magic Wand Tool)
Tímto nástrojem provedete výběr oblasti podle odstínu barvy. 
Klepnutím do obrázku se vyberou sousední pixely stejné, nebo 
podobné barvy.

 Oříznutí (Crop)
Nástroj pro vyříznutí části dokumentu. Nakreslete výběr oblasti stejně jako při použití nástroje 
Výběr (Marquee Tool) a stiskněte Enter. Obrázek se podle výběru ořízne na novou velikost a vše 
co je mimo výběr bude z obrázku odstraněno.

 Štětec (Brush Tool)
Kreslicí nástroj. V panelu Okna → Stopy (Windows → Brushes) 
můžete volit různé hroty nástroje a tím napodobovat tahy štět-
cem. Pod stejnou ikonou naleznete i nástroj Tužka (Pencil), který 
má na rozdíl od štětce vždy ostře ohraničené okraje.

 Klonovací razítko (Stamp Tool)
Retušovací nástroj. Pomocí tohoto nástroje můžete přenášet 
části obrázku na jiné místo a nahradit tak původní barvu a tex-
turu.

 Guma (Eraser Tool)
Nástroj pro odstraňování (gumování) částí obrázků.

Výběr (Marquee.Tool)
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 Přechod (Gradient Tool)
Nástroj pro vyplnění obrázku, nebo jeho části barevným přecho-
dem. Druhým nástrojem na stejné ikoně je nástroj Plechovka 
barvy (Paint Bucket Tool) pro vyplnění dokumentu, nebo jeho 
části souvislou barvou.

 Pero (Pen Tool)
Nástroj pro kreslení vektorové grafi ky. Podrobnosti o použití 
tohoto nástroje naleznete v kapitole (Path Tool).

 Vodorovný text (Type Tool)
Nástroj pro vkládání textu do obrázku. Text se vloží do 
samostatné vrstvy a můžete ho kdykoli změnit a upra-
vovat.

 Obdélník (Rectangle Tool)
Nástroj pro kreslení vektorových tvarů jako jsou čtyřúhelník, 
kruh, elipsa, mnohoúhelník, ale i přednastavených tvarů z gale-
rie Tvar (Shape).

 Kapátko (Eyedropper Tool)
Tímto nástrojem odeberete z obrázku (fotografi e) vzorek bar-
vy. Tu pak můžete použít k vyplnění dokumentu nebo ohrani-
čené oblasti pomocí nástroje Plechovka barvy (Paint Bucket 
Tool).

 Ručička (Hand Tool)
Nástroj Ruka slouží k posunování celého obrázku (ne samostatných vrstev) v okně dokumentu, 
když je obrázek tak velký, že jej nevidíte celý. Stejnou funkci aktivujete, když přidržíte mezerník. 
Kurzor myši se pak změní na ruku a po stisknutí tlačítka myši můžete obrázek uchopit a posu-
nout.

 Lupa (Zoom Tool)
Tímto nástrojem si můžete přiblížit nebo oddálit (při stisknuté klávese Alt) náhled obrázku 
v okně dokumentu. Nijak to nesouvisí se skutečnou velikostí obrázku. Stejnou funkci naleznete 
v nabídce Zobrazení → Zvětšit/Zmenšit (View → Zoom Out/Zoom In).
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Horní panel nástrojů
Většina nástrojů má své rozšiřující vlastnosti. Vlastnosti nástroje, který je aktivní, vidíte v Hor-
ním panelu nástrojů. Na obrázku jsou vlastnosti nástroje Štětec (Brush), na kterém si ukážeme 
hlavní prvky panelu nástrojů

První ikona zleva zobrazuje zvolený nástroj.
Stopa ukazuje velikost a tvar hrotu nástroje. Při klepnutí na náhled hrotu se otevře panel, 
ve kterém můžete vlastnosti hrotu změnit.
Režim nastavuje režim prolnutí nástroje do obrázku. 
Krytí nastavuje, jakou silou má nástroj působit. Snižováním hodnoty zvyšujete 
průhlednost.

Paletky
Paletky jsou samostatná okna, ve kterých jsou soustředěny příkazy dal-
ších, kombinovaných, nástrojů. Na každé paletce je jeden nástroj. Tyto 
nástroje nejsou přímo určené ke kreslení, ale pomáhají nám při organizo-
vání dokumentu. Typickým příkladem je paletka Vrstvy (Layers), pomo-
cí které můžeme pracovat s vrstvami, efekty vrstev, maskami u vrstvy 
a mnoha dalšími vlastnostmi vrstev. Jednotlivé paletky můžete zobrazit 
nebo skrýt příkazy z nabídky Okna (Windows). Paletky jsou seskupe-
ny po dvou nebo po třech do skupiny paletek, podle podobného použití 
nástrojů na paletkách. Například paletka Vrstvy (Layers) je ve skupině 
s paletkami Kanály (Channels) a Cesty (Paths).
S paletkou můžete také pohybovat po pracovní ploše a umístit ji tak, aby 
vám co nejméně překážela při práci. Standardně jsou paletky po pravé 
straně, ale často je potřeba přesunout je do spodní části pracovní plochy, 
aby nebránily zobrazení nějakého širokého dokumentu. Umístěte kurzor 
na horní okraj paletky, stiskněte tlačítko myši, paletku přesuňte na jiné 
místo a tlačítko uvolněte.

Paletka Vrstvy (Layers)
Na paletce Vrstvy si ukážeme, jak správně paletky používat a kde 
hledat příkazy pro práci s paletkami. Většina příkazů lze vyvolat 
několika způsoby. Na této paletce je nejpoužívanější nástroj, bez 
kterého nevytvoříte žádný dokument. Každý dokument je totiž 
tvořen alespoň jednou (základní) vrstvou. 

1. Otevřete nějaký dokument (může to být fotografi e, ale 
i nový, prázdný, dokument).

2. Pokud ji nemáte na ploše otevřenou, otevřete paletku vrst-
vy příkazem Okna → Vrstvy (Windows → Layers).

Obrázek Ú.4 Vlastnosti nástrojů

Obrázek Ú.5 
Zobrazit / skrýt 
paletky

Obrázek Ú.6 Paletka Vrstvy 
(Layers)

Horní panel nástrojů
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Úvod14

3. V paletce vidíte zmenšený náhled vrstvy pojmenovaný Pozadí (Background). Toto je 
základní vrstva každého dokumentu.

Nová vrstva
Vytvořit novou prázdnou vrstvu je základní operace, kterou je potřeba se naučit. Máte čtyři 
možnosti jak na to:

1. Zvolte příkaz Vrstva → Nová → Vrstva (Layer → New → Layer).
2. Stiskněte klávesovou zkratku Shift+Ctrl+N.
3. Zvolte příkaz Nová vrstva (New 

Layer) z menu paletky vrstvy, které 
otevřete klepnutím na tlačítko se 
šipkou v pravém horním rohu palet-
ky. V tomto místě má menu každá 
paletka a v něm nečastěji používané 
příkazy.

4. Klepněte na ikonu Vytvořit novou 
vrstvu (Create a new layer) ve spod-
ní části paletky. Zde se na většině 
paletek nacházejí tlačítka s nejčastě-
ji používanými příkazy k rychlému 
použití.

Nová vrstva se vždy vytvoří nad právě 
aktivní vrstvou.

Průhlednost vrstev
V horní části je nástroj pro úpravu 
průhlednosti Krytí (Opacity) vrs-
tev. Každou vrstvu kromě základ-
ní můžete udělat částečně, nebo 
zcela průhlednou a nechat skrz ni 
prosvítat vrstvy ležící pod ní.

1. Otevřete nějaký obrázek 
a vytvořte v něm novou 
vrstvu.

2. Zvolte nástroj Eliptický 
výběr (Elliptical Marquee 
Tool) a nakreslete kruho-
vý výběr oblasti.

3. Výběr vyplňte bílou barvou 
příkazem Úpravy → Vypl-
nit → Barvu pozadí (Edit 
→ Fill → Background 
color).

Obrázek Ú.7 Menu paletky Vrstvy (Layers))

Obrázek Ú.8 Změna Krytí (Opacity) vrstvy
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4. V horní části paletky klepněte na šipku vedle okénka Krytí: 100 % (Opacity: 100%). 
Posuňte posuvník na hodnotu 50 %. Tím jste snížili krytí vrstvy na polovinu a přes 
původní bílou plochu uvidíte částečně původní obrázek.

Prolnutí vrstev
Kromě Krytí (Opacity) vrstev můžete nastavit režim vzájemného prolínání (interakce) vrstev. 
Jedná se o speciální fi ltr, který provede s barvami jednotlivých vrstev operaci jako například 
vynásobení barev, zesvětlení, ztmavení, změnu sytosti a podobně. Vrstvy se pak mohou navzá-
jem ovlivňovat a vytvářet fantastické kombinace. Změna režimu prolnutí vrstev je v knize často 
používána. Funkci si jednoduše vyzkoušíme na vzájemném pro-
lnutí dvou stejných vrstev.

1. Otevřete nějaký obrázek nebo fotografi i.
2. Příkazem Vrstva → Duplikovat vrstvu (Layer → Dupli-

cate Layer) vytvořte kopii základní vrstvy.
3. V horní části paletky klepněte na šipku u seznamu režimů 

krytí. Ze seznamu vyberte režim Násobit (Multiply).
Celý obrázek se ztmaví a získá větší kontrast. Odstíny barev 
obrázku se navzájem vynásobily, takže co bylo tmavé, je dvakrát 
tmavší a naopak, co je světlé, světlejší. Vyzkoušejte si postupně 
všechny režimy prolnutí, ať lépe pochopíte, jak se vrstvy navzájem 
ovlivňují.

Změna barvy
Nastavení barvy můžete provést tak, že naberete barvu z některé části obrázku pomocí nástroje 
kapátko, nebo si barvu sami namícháte. Photoshop rozlišuje dva základ-
ní druhy barev. Barvu popředí (Foreground color) a pozadí (Background 
color). V základním nastavení je barva popředí černá a pozadí bílá. Tyto 
dvě barvy vidíte ve spodní části panelu nástrojů jako dva barevné čtvereč-
ky.
Barva popředí bude automatic-
ky použitá při kreslení nástro-
jem Štětec (Brush). Barvou 
pozadí se vyplní základní vrstva 
dokumentu, nebo se jí nahradí 
vymazané části základní vrst-
vy. Tyto dvě barvy ale můžete 
používat i jako zásobník barev. 
Když potřebujete kreslit střídavě 
dvěma barvami, nastavte si jed-
nu jako barvu popředí, druhou 
jako barvu pozadí a pak se mezi 
nimi přepínejte klávesou X.
Barvy změníte tak, že klepnete 
na čtvereček barvy na pane-

Obrázek Ú.9 Režim prolnutí 
vrstev

Obrázek Ú.10 
Nastavení barev

Obrázek Ú.11 Změna barvy

Prolnutí vrstev
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lu nástrojů a barvu pak nastavíte v panelu Výběr barvy (Color Picker). Uprostřed panelu je 
proužek se spektrem barev s posuvníkem. Ten umístěte na odstín barvy. V levé části panelu 
pak nastavíte, jak bude barva tmavá. Zkušenější uživatelé můžou nastavit barvu přímo číselnou 
hodnotou, nebo hexadecimálním kódem (#3d64e0), který se používá při tvorbě internetových 
stránek. Tento kód také používáme v příkladech, u kterých je potřeba nastavit přesný odstín 
barvy.

Pracovní plocha dokumentu
Každý obrázek, ať je to grafi ka, fotografi e, nebo nová čistá plocha je pro nás dokument. Kaž-
dý dokument se otevírá do samostatného okna. Dokument se v okně může zobrazit v různém 
zvětšení nebo zmenšení, které ale nemá žádný vliv na skutečnou velikost dokumentu. Jaké máte 
právě nastavené zobrazení, zjistíte v levém 
dolním rohu okna dokumentu, kde se zob-
razuje hodnota v procentech. Zde můžete 
také zobrazení změnit. Zobrazení na 100 
% představuje skutečnou velikost při pro-
hlížení obrázku na monitoru počítače. Sku-
tečnou velikost při tisku zjistíte jednoduše 
tak, že klepnete do spodní části okna doku-
mentu.
Pro změnu zobrazení můžete také používat 
příkazy z menu Zobrazení (View). Zobra-
zení zde můžete zvětšit, zmenšit, zarovnat 
do celé obrazovky, nebo zobrazit dokument ve skutečné velikosti.
Pokud je obrázek tak veliký, že se nevejde do okna dokumentu, můžete s ním pohybovat pomocí 
posuvníků na pravé a spodní straně okna. Také můžete obrázkem pohybovat pomocí nástroje 
Ruka (Hand), nebo jednoduše tak, že stisknete mezerník, stisknete levé tlačítko myši, posunete 
dokument a klávesu a tlačítko uvolníte.

Obrázek Ú.12 Velikost dokumentu pro tisk
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